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Disclaimer

Notice of Disclaimer: The Colorado Department of Transportation (CDOT) provides this document on an “as
is” basis. All warranties and representations of any kind with regard to said document is disclaimed, including
the implied warranties of merchantability and fitness for a particular use. Under no circumstances will CDOT,
or any of its officers or employees be liable for any consequential, incidental, special or exemplary damages
even if appraised of the likelihood of such damages occurring. The CDOT does not warrant the documents
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Notice

This manual may be freely copied or distributed for the purpose of providing the Colorado Department of
Transportation and Colorado customers a consistent guide to using the Bentley suite of products to meet
CDOT's design and drafting standards.

Software Versions

The software products referred to in this publication are furnished under a license and may only be used in
accordance with the terms of such license. This document intended for use with the following software
Versions:

MicroStation® version 08.09.04.51
InRoads® version 08.09.02.16
0209 — Version 04.00.00 CDOT Configuration
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Document Conventions

There are several conventions that are used throughout this document to indicate actions to be taken or to
highlight important information. The conventions are as follows:

ltem

View Perimeter

Tools > Options

Document Name

Emphasis

Hyperlink

Key in

Quote

Note: text

1. Numbered Steps

<D> or Data

<R> or Reset

<T> or Tentative

Meaning

a command name or a file that you are to select

a command path that you are to select — usually from the pull-down
menus

the name of a document that is not hyper linked

style used when referring to important word or phrases

style used when you have a direct link to another document on the web

entering data with the keyboard

style used to indicate an external source quotation

information about a command or process that you should pay
particular attention to

actions that you are to perform as part of the lab activities

press the data button on the mouse

press the reset button on the mouse

press the tentative button on the mouse
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Chapter 1 - Getting Started with M

Bentley XM e

DEPARTMENT OF TRANSPORTATION

Objective: The goal of this first chapter is to present all the information needed to 1) begin a new design
project in XM, and 2) migrate a project from the Bentley 2004 software to the XM version.

Introduction

CDOT encourages all new design projects and project in the early part of the design phase to use MicroStation
and InRoads XM. Additionally, the CDOT V04.00.00 Workspace environment has been developed to support
the XM version of the software. The CDOT V04.00.00 Configuration has been released to run on MicroStation
V8 XM 08.09.04.88 and Bentley InRoads XM Edition VV08.09.02.16 and later. The upgrade to MicroStation
XM did not require any major changes to the CDOT Standards; however, enhancements, modifications, and

bug fixes have been completed with this upgrade.

This chapter is broken into three sections: 1) Starting a New Project in XM, 2) Migrating a Project from 2004
to XM, and 3) Enhancements and What’s New. In addition to the instruction found in this document, many of
the standard CDOT workflows have been updated to work with the CDOT V04.00.00 workspace. Use the
workflow links in this document to access more detailed information contained in the workflows.

Important!  The location of the resources for the CDOT configuration has changed as
shown below.

‘M Computer
&L, Local Disk (C)
Workspace
Workspace-CDOT_XM

COOT Motes
Civil Data
Project Template
Standards-Global
Standards-Local

Starting a New Project in XM

Creating New Projects in XM

An updated project creation utility is available to generate projects for XM. Use the Project
Creation Utility to setup the initial directory structure for your new project. Locate and run the
Project Creation Ultility, ProjectCreationUtility.exe, by browsing to
C:\Workspace\Workspace-CDOT_XM\Standards-Global\MicroStation\exes\. See the
workflow CDOT Project Creation and PCF File Management.pdf for additional
information on how to use this program to create a project and modify the project configuration
file (PCF) for a network location or folder share.
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Setting Up InRoads for New Projects

A new registry file has been added as an

InRoads resource to help users locate project specific

files for use in InRoads. This file automates the process for setting project defaults and should
be used for both new projects and project migrating from InRoads 2004. To take advantage of

the functionality of the new registry file,
InRoads XM Project Defaults Manag

follow the instructions in the document CDOT
ement.pdf.

Migrating a Project from 2004 to XM

Migrating an Existing PCF to XM

The first step to convert a current VV8 2004 project to XM is to upgrade your PCF. This will add
the project to the Projects list in the MicroStation Manager dialog box and will ensure the
project references will be found. The following step will demonstrate the changes that should
be made. Project number 12345 will be used for this example.

Copy your project configuration file (12345.pcf) from the directory C:\Program

Files\Workspace-CDOT\Standards-Local\Projects\ and paste it to C:\Workspace\Work-

Open the 12345.pcf file with Notepad from C:\Workspace\Workspace-CDOT_XM\Stan-

1.

space-CDOT_XM\Standards-Local\Projects\
2.

dards-Local\Projects\
3.

Locate the variable CDOT_WKSP within the text of the 12345.pcf file as shown below.

| 12345 pcf - Notepad

o X

—

File Edit Fermat View Help

Project Directory
MS_DEF=C: /Projects,/12345/
reference Files
MS_RFDIR=%(MS_DEF)
MS_RFDIR=%(MS_DEF)Bridge/Drawings/
MS_RFDIR=$(MS_DEF)Bridge/Drawings/Reference_Files/
MS_RFDIR=$(MS_DEF)Construction/Drawings,/
MS_RFDIR>$(MS_DEF)Construction/Drawings,/Reference_Files/
M5_RFDIR=%(MS_DEF)Landscape_Environmental /Drawings,/
MS_RFDIR>$(MS_DEF)Landscape_Environmental,/Drawings/Reference_Files/
MS_RFDIR>$(MS_DEF)Hydraulics/Drawings/
MS_RFDIR>$(MS_DEF)Hydraulics/Drawings /Reference_Files/
MS_RFDIR>$(MS_DEF)Materials_ceotechnical/Drawings/

MS_RFDIR>$(M5_DEF)Design/Drawings/
(Mms DEF)Des1gn/Draw1ngs[Reference_F11es/
(M5_DEF ) ROW_SURVEY,/Drawings/

M5
M5
M5

RFDIR>
RFDIR>
RFDIR>

(MS_DEF )ROW_SURVEY,/Drawing
(Ms_DEF)Traffic_ITS/Drawin
(Ms_DEF)Traffic_ITs/Drawin
MS_RFDIR>$(MS_DEF)utilities/Drawings
M5_RFDIR=$(MS_DEF)Utilities/Drawings
MS_PLTFILES=$(M5_DEF)}Plot_Sets/
M5_DGNOUT=%(MS_DEF)
M5_IMAGEOUT=%(M5_DEF)

"

M5
M5

RFDIR>

MS_RFDIR> (MSZDEF)Materia1s_Geotechnica1/Drawings/Reference_FiWes/
RFDIR> |

s/Reference_Files/
gs/ ,
95/Reference_F1WeS/

/Reference_Files/

CDOT_WKSP=C:,/Program Files/Workspace

-CDOT
oads /Preferences/

Page 10
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4. Change the path of this variable to; C:/Workspace/Workspace-CDOT_XM/

"] 12345.pcf - Notepad = | B

| File Edit Format View Help

#Fomm Project Directory ----|
MS_DEF=C:/Projects/12345/
L rReference Files —--—---

M5_RFDIR=%(M5_DEF)
MS_RFDIR>$(MS_DEF)Bridge/Drawings/
MS_RFDIR>3(M5_DEF)Bridge,/Drawings /Reference_Files/
MS_RFDIR>3(MS_DEF)Construction,/Drawings/
M5_RFDIR>$(M5_DEF)Construction/Drawings/Reference_Files/
MS_RFDIR>$(M5_DEF)Landscape_Environmental /Drawings/
MS_RFDIR>$(M5_DEF)Landscape_Environmental/Drawings/Reference_Files/
MS_RFDIR>$(MS_DEF)Hydraulics/Drawings,/
MS_RFDIR>$(MS_DEF)Hydraulics/Drawings/Reference_Files/
MS_RFDIR=$(MS_DEF)Materials_ceotechnical /Drawings/
MS_RFDIR=$(MS_DEF)Materials_ceotechnical/prawings/Reference_Files/
M5_RFDIR=$(MS_DEF)Design/Drawings/
MS_RFDIR>$(MS_DEF)Design/Drawings /Reference_Files/
MS_RFDIR>$(MS_DEF)ROW_SURVEY,/Drawings/
M5_RFDIR=$(MS_DEF)ROW_SURVEY,/Drawings/Reference_riles/
MS_RFDIR=$(M5_DEF)Traffic_ITs/Drawings/
MS_RFDIR>$(MS_DEF)Traffic_ITs/Drawings/Reference_Files/
MS_RFDIR>F(MS DEF)Utﬁ11tieS/DrawﬁngS?
MS_RFDIR>3(M5_DEF)uUtilities/Drawings,/Reference_Files/
M5_PLTFILES=%(M5_DEF)Plot_Sets,

M5_DGNOUT=% (M5_DEF) Change the path of the
QS IMAGEOUT=%(M5_DEF) CDOT_WKSP variable
CDOT_WKSP%: wWorkspace,/Workspace-CDOT_XM

CDOT_PREF=F L0 T_nrer orang = cads/pPreferences/

5. Save the changes to the file by choosing File>Save and then Close notepad.

6. Launch MicroStation and at the MicroStation Manager dialog box your project will be
available from the Project pull down.

A MicroStation Manager - C\Workspace\Workspace-CDOT_XM\Standards-Global\MicroStation\Seed\, l&]
Lookin: |} Seed et rE DHEE 3D - V8 DGN
= Name Date modif... Type Size
bl |#]2D-5eed_CDOT.dgn

Recent Places | #|3D-Seed_CDOT.dgn
¥ Bridge-3D-5Seed_CDOT.dgn

CDOT USER

LY

Computer

- Fils name: 30-Seed_CDOT.dgn - Open User: [CDOT User -
Network
Files of type: MicroStation DGN Files (*.dgn) - | | Cancel ] F‘mjec:t:l No Project ]

[Z] Open as read-only Options interace e
MNew...
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Updating Levels for XM

MicroStation XM has been modified with a new interface and added functionality. Existing
MicroStation V8 2004.dgn files will not have to go through any kind of conversions in order to
update them to MicroStation XM. The exception would be if the dgn file needs any existing
levels updated. Steps to do this can be found in the CDOT Level Update for V04.00.00.pdf
workflow file.

Migrating Existing InRoads Project Data

A new registry file has been added as an InRoads resource to help users locate project specific
files for use in InRoads. This file automates the process for setting project defaults and should
be used for both new projects and project migrating from InRoads 2004.

Project Defaults

The document CDOT InRoads XM Project Defaults Management.pdf has been created
specifically for CDOT’s implementation of InRoads XM. Refer to this workflow for more
information on how to use preconfigured InRoads default settings to locate project specific
InRoads files and how to manage the data file that controls these settings.

Migrating Existing InRoads Project Data

Existing dtm and alg files from past projects can be used without any translation when
migrating existing projects from InRoads 8.5 to InRoads 8.9 (XM). However, once the files
have been edited in InRoads XM, they will require a translation to be opened in InRoads 8.5.

All other InRoads files will need to be created from scratch. Several new CDOT standards have
been developed to help with this effort. As an example, the new template library includes
several predefined components and end conditions to facilitate the creation of cross sections.

Enhancements/What's New

New Interface

MicroStation XM has a new interface. A detailed description of the new and enhanced interface
features will be included in a MicroStation XM document that will be available mid February.
Highlights of the new interface include:

e Enhanced Button Assignments

e CDOT Tool Box - An icon has been added to the CDOT Tool Box so the user can get the
active angle for 3 pts.

e Getting Help - A pull-down menu has been added to the CDOT MicroStation XM
interface enabling users to select a comprehensive selection of CDOT help tools. These
include CDOT internal links to the CDOT Home Page, CADD Manual, Workflow
manuals, and Request and Support.

Page 12
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Annotation Scale with References

MicroStation XM has enhanced the use of the annotation scale located in the model properties
to control the size of linestyles in addition to text elements. This new capability helps alleviate
some of the tedious efforts with changing your project scale of your sheet files. There is a new
setting in the Reference Manager to verify that will ensure that your reference displays as

intended.

1. Open Reference Manager

2. Double click on the reference name to bring up the Attachment Settings

3. The new setting is called Global LineStyle Scale. By default it is set to Master, which is ok
for files that the annotation scale to control the linestyle scales.

M Attachment Settin

gs: 12345 topo 100 scale.dgn

Maodel

Description
Scale (Master:Ref

Mested Attachmert
Display Overides

True Scale
Scale Line Styles

File Mame:
Full Path:

New Level Display:

reference filesh 12345 topo 100 scale.dgn
- [cDOT Defaut - |

Logical Mame:

. | Global Origin aligned with Master File
) | 1.000000 - | 1.000000

- [No Nesting -| Decth: [1
- [ Allow -|

Display [] Clip Back.

Snap [] Clip Front

Locate Display Raster References

[] Manipulate as Blement [ lonore Attachment When Live Nesting

12345 Topo 100 scale dgn Browse...

Migrating CDOT Projects & MicroStation XM Update Guide
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4. Select the pull down and change this to None. The toggle None is appropriate for drawings
that have hard coded the linestyle scale to the elements. CDOT files that do this are the Sur-
vey files. On all survey referenced files the Global LineStyle Scale will have to be changed
to None in the Attachment Settings.

#L Attachment Settings: 12345 topo 100 scale.dgn lé]
File Name: | 12345 Topo 100 scale.dgn Browse. .
Full Path: . ‘reference_files'12345topo 100 scale dagn
Model: [CDOT Defautt -|
Logical Name:

Description: | Global Origin aligned with Master File
Scale (Master:Ref) | 1.000000 : | 1.000000

Nested Attachments: [No Mesting -| Depth: | 1
Display Ovemides: [Allow -

Mew Level Display:l Mone
Global LineStyle Scale  » Master
Reference

Display Master * Reference
Snap T IS o
Locate Lisplay Raster References
[ Manipulate as Element [ lgnore Attachment When Live Nesting
True Scale Use Light
Scale Line Styles Plot As 30 (PDF)
=

5. Select Ok to close the Attachment Settings and close Reference Manager. Your linestyles
will display as expected.

Changes to InRoads

There are several changes to the InRoads environment that impact the current CDOT
workspace. These include: changes to the InRoads file formats, a new preference file format,
and new template and roadway library formats.

File Formats

The file format for InRoads data files has changed as noted in the following table:

2004 XM
Format Format

Preference file Nl Xin
Surface file .dim .dtm
Alignment file .alg .alg
Template file mi Hii
Roadway Definition file Twi rd
Reporting .dba Xml

Page 14 Migrating CDOT Projects & MicroStation XM Update Guide
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Users will notice three major changes related to the change in file formats:

e Templates are now component based.
e Modeling is real time
e dba reports have been replaced with xml reports.

New Preference File

The InRoads V8 preference and style files (civil.ini and wysiwy.ini) have been replaced with a
single XML formatted file with an XIN extension. This file also replaces the Survey FXP and
FWEF files. The new file is called CDOT_Civil.xin and is located here;
C:\Workspace\Workspace-CDOT_XM\Standards-Global\InRoads\Preferences

New Template Library

The InRoads 8.5 Template Library (CDOT-Typical Sections.tml) has been replaced with an
InRoads Template Library, ITL. The new file is called CDOT_Template-Library.itl and is
located in C:\Workspace\Workspace-CDOT_XM\Standards-Global\InRoads\Templates. The
new ITL file contains the Point Name List (TC names), Templates, Sections — Pavement,
Sections — End Conditions and Components. These sections of the ITL file are organized in an
explore view and contain several folder to categorize the template components.

2
B Create Template

File Edit Add Tools

Template Library:
3 C\Workspace \Workspace-CDOT_XM\Stand
EE Point Mame List
21 1- Templates
[ 2- Sections - Pavement
[ 3- Sections - End Conditions
[ 4-Components

Roadway Designer

The InRoads 8.5 Roadway Library (*.rwl) has been replaced with an InRoads Roadway
Designer, IRD, file. The new Roadway Designer is a complete corridor design tool that allows
you to run iterative design without generating InRoads files. In Designer you can manage the
corridor, template drops, point controls, end condition expressions, display references,
secondary alignments, key stations, and superelevation. Additional design tools are available to
aid in vertical gore design and curve widening to name a few.

New Plotting Solutions

The plotting features inside MicroStation XM have been updated in order to take advantage of
the many changes to the print engine and graphics display subsystem. The plotting upgrades
include enhancements that benefit direct printing, Batch Print, and PDF Composer.

Migrating CDOT Projects & MicroStation XM Update Guide Page 15
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Printer Drivers

Printer drivers control plotting devices, plot sizes, etc. The file extension for printer drivers has
changed from *. plt to *.pltcfg. Changes have been made to the printer driver configuration
files enabling them to be edited using the Printer Driver Configuration Editor inside
MicroStation. This editing interface is easier to use and understand. The new interface creates a
XML format file

Refer to the following workflows for instructions on how to adjust printer drivers and how to
use them for general and specialized printing.

e CDOT MicroStation Printing.pdf

e CDOT Batch Printing.pdf

e CDOT Printer Driver Adjustments.pdf

e CDOT Shaded Color And Grayscale Printing.pdf

Pen Tables

MicroStation pen table’s process pen weights, colors, fill, and shading, etc. Upgrades to the pen
tables have been completed to insure changes and upgrades to the CDOT Configuration print

properly.
Survey Workflow Change

The Annotation Scale setting in the Model Properties is a new enhancement in XM and cannot
be used in the Survey workflow because of limitation with InRoads Survey. InRoads Survey
will not apply the Annotation Scale to cells and requires additional Styles to be created for text
to control the many justification options. The decision to not implement the Annotation Scale
setting was made since the process was broken and wouldn’t improve the multiple scale dgn
output.

Since Survey uses the 3D-Seed_CDOT.dgn seed file to generate your dgns, a setting will have
to be changed to display Survey graphics correctly in MicroStation XM. Please follow the
following steps;

1. Open the Model Properties in MicroStation.

M Model Properties EZ

Iyps:
MName: | CDOT Default

Description: | Master Model
Bef Logical:
4, [r=or =) [100.000K]- [1.00000
Line Style Scale: [Annotation Scale )
Update Fields Automatically

Cell Properties
Can be placed as a cell Cell Type: |Graphic -

Page 16
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2. Change the Line Style Scale: settings to Global Line Style Scale and verify the value is set
to 1.0

ﬂ Model Properties 3
Type: D ~
Mame: | CDOT Default
Diescription: | Master Model
Bef Logical:
A [1m=100 x| [100.0000]:| 1.00000
iLine Style Scale:] » Global Line Style Scale 100000
Annotation Scale Iy

Cell Properties
[ Can be placed as a cell Cell Type: |Graphic -

Can be placed as an annotation

[ 0K | [ Cancel |

3. Click OK to close the Model Properties dialog box.

4. Generate your graphics with the Survey Options for Line Scale: set to the output scale you

creating.
ﬁ Survey Options @
General | Units I Symbalogy I Comections I Obsenvation Standard Deviation|
Chord Height:
Paint Seed: 1 Help
Figure Seed: 1
Cell Scale: 100.00
Text Scale: 2000 Fieldbook Audit Trail Fle Name:
Line Scale: 100.00
File Cptions
"] Resolve Code Emors [] 5ave Computed Coordinates
[ Log Code Ermors [ Add/Edit Audit Trail
] Convert Numeric Codes to Comesponding Alpha Codes on Import
View Options
Autematic Refresh Segregate Text by Symbology Level
Planimetric Settings
Use Custom Operations Attach Default Tags
[ Use Symbals Attach Attribute Tags
lse Cells
[ Include Custom Operstions, Symbals and Cells in Single Cell
[ 0K ] [ Preferences... ] ’ Cancel ]

Summary: If you experience any problems after using these instruction to get a new project running under
in XM environment or the project you migrated from 2004 is not working properly, please
contact the CDOT CADD Manager for assistance.

Migrating CDOT Projects & MicroStation XM Update Guide Page 17
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Objective: The purpose of the remaining chapters of this guide is to explain the
changes and additions that users should notice in MicroStation XM. These chapters should
function as quick reference material to users questions regarding the new MicroStation XM
environment. See the document Practical Guide for Using InRoads XM for details on the
changes that have occurred to the InRoads software and design environment.

The distribution folder on the local computer XM has changed for MicroStation. The new
directory structure conforms to the standard Windows operating system. The new default
directory structure enables Bentley to release Select updates without MicroStation needing to
be uninstalled and reinstalled.

Working Directory
Default location of Bentley Program files and Documentation.

e C:\Program Files\Bentley\Documentation
e C:\Program Files\Bentley\MicroStation

CDOT Data Paths

Location of application data and Workspace Standards resources

e C:\Workspace\Workspace-CDOT_XM\Standards-Global

Location of Interfaces, Projects, and Users

e C:\Workspace\Workspace-CDOT_XM\Standards-Local

User Data Paths

Location of the CDOT Preferences

e C:\Workspace\Workspace-CDOT_XM\Standards-Local\Prefs

Location of the CDOT AccuDraw shortcuts, Button Menu, and Function Key Menu
e C:\Workspace\Workspace-CDOT_XM\Standards-Local\Users
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MicroStation Manager

The default look for MicroStation Manager is the Windows Style dialog. The new Windows
functionality in MicroStation Manager enables the user to right click files for shortcut fly outs,
easy folder navigation, and quickly create sub folders. The familiar Bentley pull-down menus
and workspace settings are still accessible, just in new locations.

MicroStation Manager - C:\Projects\13579Design\Drawings\Reference_Filest
i i ] G 2
Loak in: | [2) Reference_Files x| & ;i - |J E:,’j 30 - W8 DGH
By Mame Size | Type Date Modifie
b ’3 }ﬂ 13579DES_Interchange. dgn SOKE Bentley MicroStatio,.,  2/6/2009 2:4
My Recent }ﬂ 13579DES_Intersec.dgn 52 KE Bentley MicroStatio,..  11f20/2008 ¢
Documents ] 13579DES _Model.dgn 384KE Bentley MicroStatio,..  2/8/2009 2:7
- }ﬂ 13579DES_Phasing.dgn 52 KE Bentley MicroStatio,..  11f20/2008 ¢
}ﬂ 13579DES_Prof.dgn S5ZKE Bentley MicroStatio...  11/20/2008 ¢
Desklop
My Documents

43
My Computer

9 e

by Metwork,

Places | File name: 13573DES_Model dan v User: | COOT User v
Files of type: MicroStation DGM Files [* dan] [v] Proect: | 13573 v

[ Open as read-only Interface: | COOT v
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Bentley New File

The New File icon = located in the upper right hand corner of the MicroStation Manager
dialog will open the ‘New’ dialog which allows creation of a new file using the active seed file.

The active seed file can be changed by selecting the Browse icon.

New - C:¥Projectsyl 357 9\Design\Drawings\Reference_Files\ E]
Savein: | ) Reference_Files b = ¥ - E’-—’j
Y .lﬂ 13579DES_Interchange, dgn

/ L] 135790E5_Inkersec. dgn
My Recent | #E]13579DES_Model.dgn
Documents | BE]13579DE5_Phasing.dan

— %i 4] 13579DES_Prof.dan

Desklop

My Documents

43
ty Computer
)
ey Mebwark
Places File name: -

Save as ype: ticroStation DGM Files (% dgn) ~

Seed: C\Workspace\wWorkepace COOT _<M4Standards-Global\MicroStation'seed 30 -Seed_CDOT dgn

Bentley Tools / File History

The Bentley Tools / File History icon = ocated in the upper right-hand corner of the

MicroStation Manager dialog lists the most recently opened files. It also provides tools to

Compress and Upgrade files.
Set Default Seed File

A new tool in the Bentley Tools list is the Set default seed file. The Set default seed file tool

opens a dialog which gives the user control on which seed file is defined when new

MicroStation files are created in Windows Explorer by the File > New > MicroStation DGN
File or by Right clicking in the explorer pane and selecting New > MicroStation DGN File

from the short cut list.

Migrating CDOT Projects & MicroStation XM Update Guide
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The Set default seed file can also be accessed by selecting;
Start> All Programs > Bentley > MicroStation V8 XM > Set Seed File

Select a MicroStation DGN Seed File for Explorer->New File

‘when creating a new DGM file:

" Azk me to pick the seed file each time

-
™ Use MicraStation’s current seed file

+ |se the seed file selected from this dialog [curently |

Look in: |_}Seed j Ll £f E-

Y M 20-5eed_COOT.dgn
Lﬁ £\ 30-5eed_CDOT.dan

MyRecent | MBridge-30-Seed_COOT.dgn
Documents

Desklop

LY

My Documents

My Computer
3 |
iy Metwark, File name: |3D-Seed_EDDT.dgn j 0K
Flaces
Filez of type: |Micr08tation DG Files [*.dgn) j Cancel

Set Default Seed File Options include:

Ask me to pick the seed file each time - will open the New dialog so the user can select
the appropriate file. By checking the Launch Windows Explorer check box will open Windows
Explorer.

Use MicroStation current seed file — will create the file in window explorer using the
current seed file defined by the last used seed file or workspace variables

Use the seed file selected from this dialog — lets the user define the seed file from the
browser section in the dialog. The current seed file as shown in the dialog.

Bentley Directory History

The Bentley Directory History icon ®d located in the upper right-hand corner of the
MicroStation Manager dialog provides a list of previously opened directories. From the
directory icon, the options for New, Copy, Compress, and Upgrade to V8 were removed.
Creating a new or copying a directory can still be accomplished in the Windows style dialog,
however to compress or upgrade a directory the option, Use Windows File Open Dialogs,
needs to be checked off under the Look and Feel category in the Workspace Preferences dialog.

Page 22
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MicroStation Manager Classic Style

To view the MicroStation Manager classic style, press the Shift and Esc keys prior to selecting
the File > Close or File > Open commands. Permanently disable Windows style dialog with the
option ‘Use Windows File Open Dialogs’ checked off under the Look and Feel category in the
Workspace Preferences dialog.

M Open
File Directory
Directories:
13579DES_Interchange. dgn . ADesigniDrawingziReference._Files' 20 -VEDGN
13579DES_Interchange. dgn |2 TN
13579DES_Intersec.dgn [ Projects
13579DES_Model. don = 13579
13579DES_Phazing.dgn (= Design
13579DES_Prof.dgn (= Drawings
P Reference_Files
.List Files of Tvpe: i .Driies: &
MicroStation DGM Files [*.dgn] W =N w
[ ReadOny
[] Shaw File |cans
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MicroStation Interface
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The MicroStation Design Interface contains a variety of tool command icons, toggles, dialog boxes, pull-
down menus, and various information displays. Most of these interface tools and options will be discussed in

this chapter as well as others.

The MicroStation Design Interface contains a variety of tool command icons, toggles, dialog boxes, pull-down
menus, and various information displays. Most of these interface tools and options will be discussed in this

chapter as well as others.

MicroStation
Title Bar Standard Tool Box

/ Menu Pull-Down Options CDOT Misc. Tools

I
4
,
A
)

Ly

"5 frove~ | Deladk ——— N B b B e @B, DA

EI';I'ELI'=':=?'35{"~1;:J"'@.1 Y

= 1 —l

?? q * A9 q O T;' A & | N A ',""' ¢ gy -
! -~

5 B

., Primary Tools Attributes View Title Bar S

ﬂj Tool Box (docked) Tool Box (docked)

ot AccuDraw Window

Bo A View Control Tool Bar

.L_i_. -'z'

bt

. = 5

x [ <«— View Window Area —*

M

Mottt | Orthogona [+ «—— Tool Settings Window

Bpes | Sobd W

Fll Typss | More (%

View Groups Tool Box (docked)
£

3] <l © % 2 x5 AT
@ - © - \ - Exeworsaan~] 2 lz[afalsls]ols \ 2 G-

Place Block » Enss first point \.—- B Dolwk

Status Bar

1

Main Tool Bar I
Task Navigation

Migrating CDOT Projects & MicroStation XM Update Guide

Page 25



Colorado Department of Transportation

Primary Tools Tool Box

Primary Tools

\Eﬂgs—jv

- 2RO TR

Models J
Referentes
Raster Manager

Level Manager

r

Level Display —

PopSet

The PopSet @

—— Cells

‘ LLLMFM

Element Information

tool works differently in XM. When PopSet icon enabled, the Tool

Settings window will automatically hide itself when moving the cursor within the buffer area
around the dialog. The buffer area is defined in PopSet Properties which can be accessed by
<R> the PopSet button and selecting Properties from the fly-out menu.FM_BD_BodylIndent

Primary Tools

@Eiﬁ@@@mi

PopSet Properties

[ Auto-Position Tool Settings;
[] AMlow Ctr+Space When Disabled
Mew Tool Delay (zeconds): | 0.75
Hide Delay (zeconds): | 0.25
Hide Border {pixels): 15
Focus ttem Description

Cption to have PopSet auto-position the Tool Settings [A
when the pointer is over a selected icon. i not set the [ ]
Tool Settings can only be shown with Cird+Space, by

maving the pointer over the PopSet dialog, or if 3 non-zero [V]

QK Cancel

PopSet is enabled if the icon is green. It is disabled if the icon is red.

Page 26
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Element Information

I/_-“\

The Element Information L dialog box has been redesigned and has additional ways for
editing element information. Information displayed varies depending on the type of element(s)
selected. If multiple elements are selected the elements will be listed in the top section
Selection tree.

# Element Info E] #“
= = % Selection
= n/ Selection 4 Text Mode
A Line Sting
Freeze/Hide ~
Freeze/Hide i
General Lewel ALG_PROPOSED_Hor-#
Color E= ByLevel [3]
. Line Style Byl evel [0]
Level ALG_PROPOSED_Hor-Cardinals ‘wheight E= BylLevel (3]
Colot ByLevel (3] ?'assl :'i"'a'i'
Line Sile ByLevel (0) o gone
Weight ByLevel (1) =
Cless Primary Test Sting 347+00
Template None Text Style {None]
Transparency 0 i
Font Mame Bl
Ssonen, Wertical False
Start Point 491783.248,1800675.573 Height 1000.000
End Paint 477175.783,1797266.472 :V"::‘rh ; lug“l-:um:
1 ushincation el enter
Lgngth 15.000.000° Slant Angle 000"
Direction S13°811.75"W LineSpacing 700.000
GNIJFS Line Spacing Type Exact
¥y
Angle N13745'42.76"E
Extended
2l = User Origin 327755.339.1623521.8
Morthing 327755.339
E asting 1623521.823
5 bl 5 bl Elevation -8947848.525
nappanie nappable Bl Origin 327874.282_ 162303615
Morthing 327874.282
E asting 1623036176
Locked Unlocked Elervation -8947848.525
Thickness 0.000 |[ Groups ]|
Lire Style Parameters
Raw Data
Shappable Snappable
Wiew Dependent View Dependent
Linkages 1
Locked Unlocked hd

Element properties can be edited from this dialog by selecting the field and either Key-inthe
new value or select from a drop-down menu.

Right clicking in the dialog will bring up the Show/Hide shortcut menu to control the display of
available tabs.
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Attributes Tool Box

The Attributes toolbar controls the element symbology prior to placement. Functionality

highlights include:

Attributes
'_l—ﬁ

@H‘

_~ [none ~ | DES_RDADWAY Tog v || == + = & == . ‘

Flement Template —T

Level Filter

v.

Element Template

Active J S}'mbolugyj

Level

Preview

works similar to Settings Manager by defining level, color, style,

weight, and type of element being placed. If the Element Template lock is enabled, any change
to the Element Template will globally update elements placed using that template.

Main Tool Frame - 2004 Edition

The 2004 Edition Main Tool Frame has been supplemented with a Task Navigation Tool Box

XM Edition XM Edition
Main Tool Box  Task Navigation Tool Box
CDOT M...[ | T [
K —
e d) .;}
+ J%
@l T p
/O —,@’
Bo, A, B
EPD D?» J.'.'T'i
X [ &

Main Tool Box

The Main tool box includes the tools that will in some manner manipulate current elements.
The numbers next to each icon represents the positional keyboard mapping assigned to each
icon. Each icon has a child toolbar that can be ripped from the parent toolbar except for the
Element Selection [1] and Delete [8] icons.

Main

x
R A sl X
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If you have the default function key menu loaded F3 will place the Main fly-out on your cursor.

k 1 Element Selection |
E_E 2 Fence 3
E? 3 Manipulate 3
;I—|q 4 View Control 4
f-:? 5 Change Attributes 3
S

.L\_:u!_ & Groups 3
7 Modify ’
x 8 Delete Element

Task Navigation Tool Frame

The Task toolbar has been added to include the primary creation tools for elements, text,
dimensions etc. The purpose of the task tool bar is to be customized in such a way that it
encourages a general workflow. Different Task lists can be displayed by selecting the Task
button on the toolbar.

Task Navigation B
SR\ R TRTOR: |8 DY N ]

Task-based Interface

When using Task Navigation think “Workflow”. By default the Tasks are in a grouping of
tools that are similar. The order of the tools can be customized to follow a specific
workflow or general progression of work.

The Task List \i icon opens the task list. Selecting a tool group from the list will
display the associated commands for the selected tool group.

Task Navigation X

[ A o 5F s y? 4F 0 ot B B0

1= Drawing
++Linear
Polygons
Circles
Pattems
Tags
T
Cell
Measure
Dimensioning
+Drawing Composition

The Page Up and Page Down keys will quickly page through the Task Navigation tools.
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If you have the default function key menu loaded F4 will place the Task Navigation Fly-out
on your cursor.

‘\i 1 Linear

2 Polygons
3 Circles
4 Patterns
5 Tags

B8 Text

7 Cells

2 IBO |

i)
b

* ¥ ¥ w ¥ v w ¥

8 Measure

5

9 Dimensioning

Use the Fly-out menu option Open as Toolbox to display a Fly-out tool box.

NS A AN

ﬁ BoABC * A Al 1, MA A A g
E Ak o3 F abc af A7 4 Y Y Y T
JJ’
| ]
(4] ] 3
: TREFPE

Ty
e 5 o

i

bt o

A S A

Positional Keyboard Mapping

Positional Keyboard mapping allows access to tools through the keyboard. The three main
toolbars that are defined with positional keyboard mapping are the Main, Task Navigation and
Tool Settings dialog. Each tool has a zone on the keyboard assigned to it. For example, the
Main tool box uses numbers 1-8 across the top of the keyboard.
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Main tool box

The Main tool box has keyboard numbers assigned to it. Pressing a number is the same as
selecting tools from icons. For numbers 2-7, a Fly-out list will appear on your cursor showing
the additional tools from that child toolbox, either select the tool with the cursor or continue
utilizing the keyboard mapping.

Main

x
R b e X

.gHHHHHH

HEEEER 1
FEETT I
I = ] ]
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Task Navigation

Task Navigation has the left side of the keyboard assigned to it. Pressing a letter will
accomplish the same thing as selecting an icon. By pressing a letter, a Fly-out list will appear
on the cursor showing the additional tools from that child toolbox. A tool can be selected with
the cursor or by continuing to utilize the keyboard mapping.

Task Navigation 3

2 @bl g el B g g

jﬁ%ﬁ%%‘%ﬁ%w mme

[ [ | J

Status Bar

The Status bar has added one new section to display if the Design History '~ has been
initialized. By selecting the Design History icon in the status bar you can initialize it.

one of four options depending on which dlalog has focus.

. Fence Save
Smap  Active Indicator Indicator Home
Modes Level

L ﬁﬂl

\Hmemmmmfm“m of | @ Defaut ! | ﬁj"
Tool mpt I I '—[ ’—T ’_‘[
Selection Message Locks  Element Workmode Desien
Center Selection Indicator HISEH
Command File Protection
Prompts

The Home section of the status bar will display one of four options depending on which dialog
has focus.
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"*_ Home allows use of the positional keyboard mapping.

% ool Settings dialog has input focus.
=1 AccuDraw dialog has input focus.

= Key-in Browser has input focus.

Additional Keyboard Focus

Escape — will take you to the Home position in the Status Bar
Enter — will open the Key-in Browser at your cursor
Spacebar — will change the focus to the AccuDraw dialog
Tab — will cycle elements that overlap (use instead of right click)
Page Up — move up in the Task Navigation tool box tree

Page Down — move down in the Task Navigation tool box tree
F9 — will open the key-in browser at your cursor.

F10 — change focus to Tool Settings window

F11 — will change the focus to the AccuDraw dialog.

F12 — will take you to the Home position in the status bar

Tool Settings Window

Many tools in MicroStation offer several different options that can be utilized to achieve a
specific way elements are created or modified. These various tool options are located in a
special dialog box, referred to as a window (Tool Settings window).

The Tool Setting window has the right side of the keyboard assigned to it. Pressing a letter will
accomplish the same thing as selecting an option in the dialog. To see which letters are
assigned to the Tool Settings window select the Escape key and the letters will temporarily
appear.

"
Poroy
e m® N
j

Main things to remember regarding the Tool Settings window are:

e The Tool Settings window can be moved or relocated anywhere on or outside the
MicroStation application window by left-click and dragging on the title bar.

e The Tool Settings window can be docked along the side of the application window.

e To display the options for a specific tool, simply click on the tool and the Tool Settings
window will automatically display the specific options available for that tool.
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e If there are no additional options available for a specific tool, the Tool Settings window
will still be displayed, showing just the active tool in the title bar.

Mouse Mechanics

See the CDOT workflow document CDOT Mouse Clicks in MicroStation XM for information

on changes and enhancements.

Drawing File Enhancements

Design File Settings

The Working Units category in the DGN File Settings dialog has a new layout and includes the

coordinate readout settings.

® DGH File Settings

|sometric:

Accuracy: | 012

Focus Item Description

Select category to view,

Categary Fodify ‘Working Unit Settings

Active Anal Linear Units

pubvetrde TR
Az Mazter Unit: | Survey Fe| | Label: |

Color Sub Unit;  Survey Ing » | Label "
Element Attributes Accuracy | 0123 ==

Ferice -

Grid Advanced Settings

Resalution: 12000 per Digtance Survey Foot
Lacks woorking Area;  1.42153E +008 Miles
Solids &rear 157,929 Miles

Solidz Accuracy:  8.33333E-006 Survey Feet

Rendering

Shapz

Stream Angles

Wigws Format: | DD M S5 | ]]]]
working Units Mode: | Bearing ¥

o

Drawing Scale

A Drawing Scale dialog has been added to the pull-down menu at
Settings > Drawing Scale. This dialog can docked into the top or bottom of the

MicroStation application window.

M Drawing Scale
Inches o
1 |Full Size 1=1
CUSTOM ACS
L Full Size 1=1
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Tool Enhancements

Place Line

The place line tool includes a solution option when placing a line using the perpendicular or
tangent snap. A second solution will be shown as a dotted shaded line.

]
M
[] Length: 25715567
] Angle: =
Solution: Nearest |w|

Pressing the ALT key will toggle between available solutions.

Place Arc

e Method: placement of arcs has been expanded from the two choices of Center and Edge.
Now the placement can be done in different orders Start, Center or Center, Start. The
Edge placement options include Start, Mid, End or Start, End, Mid.

e Direction: An option for constraining the direction of arc from Clockwise (CW) or
Counter Clockwise (CCW).

e Solution: Similar to the place line tool enhancement, there is an option for displaying
multiple solutions when using the perpendicular or tangent snap.

& Place Arc E]

Method | Start, Center  |w)

[1 Badius: 158.5917
[] Length:

[] Start Angle: 332 504°
[] Sweep Angle:

[] Direction: oW [w
Solution: Nearsst [w/
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Cells
Place Cell Index

The Place Cell Index will create a display of the cells that are attached to the current model.
The Index layout will be stored in the current model file with the cells being referenced in.
If cells are deleted or added to the cell library the index will not automatically be updated

to show those changes. In that situation the cell index will need to be created.

O 9 St

Ir’} e wj{ S SN ﬁ

“

Box Size (in characters): | 20
Cells per Row: | 10
Grd Lines

Mames
[ ] Descriptions

[] Insertion Points
[ ] Enable Screen Menu

O %K
BM [ROW

Ligh! Pode Wosd Lighi Pest Flog-Pole Filbas, UTL STOAW lakt UTIL ETORW Wankale

e ke .

Zyn UTL ELEC Pale UTIL GAS Mareals LTI GRS Wglue uTL G UTL FOLE

>

UTH, SaMTART Wonrhgle | UTL waTER Fire Hygeond | UTIL WRTER wolus T WATER Wal uTe, ELES Biox

S

Earvch Mok ROW Mgt £_Trsm bTres
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Place Active Cell

New options have been added to the Tool Settings dialog for placing cells.

—
B
L

whs

#,f}w‘rg— /q-#}ﬁ

"M Place Active Cell (=) W

Active Cell: | Sign
Active Angle: | 0°0°0.00"

True Scale

[] Belative

Mirror: Horizorital |+ |
[] Interactive

Scale Multidine Cffsets
Scale Dimension Values
Scale Annotations
Asspciation

# Scale: | 1.000000
:E 1.000000
£ Scale: | 1.000000

=

L g 1k¥.0

[ 2

Mirror — at placement options include Horizontal, Vertical, and Both.

Interactive — at placement options include Rotate and Scale, Rotate Only and Scale Only.

Scale
Scale

Scale

Multi-line Offsets — at placement the active scale is applied to multi-line offsets.
Dimension Values — at placement the active scale is applied to dimension values.

Annotations — at placement the active scale is applied to elements that use

annotation scale.

AccuDraw

Shortcut Key-ins

HA -
—“AccuSnap Toggle” will toggle off or on AccuSnap; replaces J.
HU -
— “Rotate Element” will rotate the AccuDraw compass to an element that is identified.

HS

RE
RV -

“AccuDraw on Hold” will remove the AccuDraw compass for one data point.
“AccuSnap Suspend” will suspend AccuSnap for one time command; replaces U.

“Rotate View” will put the view into dynamic rotation mode.
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Settings

Operation: Auto Focus Fields will change the focus and lock the field when the shortcut
key-ins A, and D are used.

#b AccuDraw Settings g [

Operation | Display |Coordinates|

Auto Load [] Auto Poirt Placement
FHoating Origin [] Sticky Z Lock

Contest Sensitivity [] Mways Show Compass
Smart Key4ns Auto Focus Fields

Default Origin: | View certer on active Z [

Display: Added option for compass fill and dialog size. In addition, an option exists to
display coordinate values on the cursor during placement.

#b AccuDraw Settings g O

Operation |  Display |Coordinates|

Kands: | I v

[] Delayed Update
Y s | [V]

Display Coordinates

Hiltte: ] Show Negative Angles
Frame: [l Pop-up Corfimations
Fill: | — ]

Dialog Size: | Medium [w]

A ¥ 520013
™. | ¥:10256.23 |
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Manipulate
Scale

The Scale Tool Settings dialog has added new features and has been reorganized. The
About Element Center check box has been moved from the expanded

B8
I:I? 5::5? :Il* dﬁ. Sg &I E C?EJ D¥|

# Scale g [
Method: | Active Scale [Y]
X Scale: | 1.000000
¥ Scale: | 1.000000 &
£ Scale: | 1.000000

[] About Element Certer

[ ] Copies

Scale Multidine Cffsets
Scale Dimension Values
Scale Annotations

Construct Array Along Path

The method Along Path has been added to the Construct Array tool. This method has
different ways of accomplishing this by Distance, Number, or Both.

B8

r!u Construct Array g [ -\

Method: | Along Path [+
Mode: Distanu:e[V]

Dlstance 12.000

Number — defines the number of items placed along a path.

Distance — defines the distance between items placed along a path.
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Both — defines both the number and distance of elements placed along the path.

2 A2 RARBRD G
L'ﬂ
Method: | Along Fath |w]
Mode: | Distance ||
Distance: | 12.0000
[] Botate tems H O USE

-
735 % ABg D @

[}

‘M Construct Array g (m}

Mode: | Distance [v|

Distance: | 12.0000

[] Rotate tems HOUSE
oA ~ ,;J
A R e é), """""" '_";«“"lzg’*“:ﬁ.,, b Pl
R O
A\
\
Stretch

The Stretch command has been added to the Manipulate tool box as an individual tool. If a
fence does not exist in the drawing the place fence tool automatically is initiated.

B
e it 00 O3

=
o%e)
00

=
I

M
X

Stretch Cells
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Move to Contact

Move to Contact has been added to the manipulate tool box as a means of moving
individual or a selection of elements to another element. This tool was added to help
manipulate elements in 3D designs but can be applied in 2D designs as well.

Manipulate ¢
232 % A3 b &

M Move to Contact |- ||O

Before:

After:

Modify
Break Element
The Break Element tool will break the element at the identified location.

Modify x|

X K S E T DRI Y N

rﬂ Break Element g |
| |

Migrating CDOT Projects & MicroStation XM Update Guide Page 41



Colorado Department of Transportation

Page 42 Migrating CDOT Projects & MicroStation XM Update Guide



Chapter 4 - Element Selection and
Information i

= e e, Ty
DEPARTMENT OF TRANSPORTATION

Element Selection

Element Selection tool has been incorporated into PowerSelector. Additional options include
Disable Handles and Select Handles which allow multiple elements in a selection set to be
modified by their handles.

# Element Select... E] O

[flozo. &
Bl =@ 3% N

v

e <D> nothing in the view will clear the selection set.

e Citrl + <D> will add elements to a selection.

e <D> + drag will create an inside block mode.

e Citrl + Shift + <D> + drag will switch to overlap block mode.
e <D> <D> will switch to the active block mode in the dialog.
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Positional Keyboard mapping for Element selection are YUIOP and HJIKL;

eyor 8
Wleu® B
F

Handles

Handles have added functionality that help with editing a number of element types. In addition
to references, reference clip boundaries, and named fences.

Handle Display

Toggling the display of element handles is done by selecting the button on the lower right
side of the Element Selection Tool Settings dialog.

W Element Select... (=l|E=Ub M =5
Bler=-ax N B+ = @ EE

000 1©58]

Alternate Handles

Alternate handles displayed as filled circles can be seen with certain elements such as Text.
With the alternate handles modifications such as text wrapping can be accomplished.

{OVERHEAD SIGNAL MOUNTING STRUCTURE - 25' SPAN

‘OVERHEAD SIGNAL MOUNTING

@ @

Move
1. Select the elements.
2. Place the cursor over a selected element, not a handle.

3. <D> + drag the elements to the new location and let go.
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Copy

1. Select the elements.
Place the cursor over a selected element, not a handle.

<D> + drag the elements to the new location.

A w N

As you drag press and hold the Ctrl key an icon plus sign will appear next
to the cursor indicating the elements will be copied.

5. When you are at the location to place the copied elements, release the
<D> button

Modify

When an element or elements are selected the handle or handles can be selected by holding
the Ctrl key and when the elements are modified the geometric relationship is maintained.

Alternate Modify

To modify handles and not keep the geometric relationship hit the Alt key once to toggle
off geometric relationship.

N
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Fences

Copy/Move Fence Contents

Copy Fence Contents to New File tool was added to the Fence toolbar. This icon replaces the
key-ins “Fence File” and “Fence Separate” which will copy and move the contents of a fence to
a new drawing.

M Copy Fence Contents to New File E] 1

Output File: | _whats new__Index.dan q
Processing Mode: | Copy []

Fence Mode: | Inside | )
[] Switch to generated file

Saved Fences

Saved Fences have been added to the expand section of Tool Settings window for the place
fence tool. A saved fence allows the user to recall and managed different fences in one

drawing.
& Place Fence E]
Fence Type: | Block ™
Fence Mode: | Inside [ ] a
X &
| Name D&Bc:'phon [=]
Plotting 2234 hp 1055
|Clip Boundary  plan view
|Clip Boundary2  profile view

Measuring

The measuring tool has added a new long awaited feature. The new Mode options now include
True, View, and AccuDraw/ACS. These options will allow measurements to be View/
Horizontal or True/Slope measurements.

Distance: | 75.0000m
Accumulated Distance: | 75.0000m
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Element Information

@

The Element Information

dialog box has been redesigned and has additional ways for

editing element information. Information displayed varies depending what type of element is

selected. If multiple elements are selected the elements will be listed in the top section

Selection tree.

#L Element Info g O A Element Info g m|
= & <Selection: = & <Selection:
#/ Line String A Teat: RODDY RIVER
General & [ General &
Description
Level E WTR Level E WTR
Color N 103 Color N 103
Line Style o \nieight o
\nieight o Class Primary
Class Primary Template None
Template None Transparency 1]
Transparency 1] [ Contents 5
| Geometry & Text String RODDY RIVER
Text Style {None)
Sogmonts [ Formatting 2
. Font Name =]
Elevation 0.0000 _ Vertical False
| Extended Height 175.0000
\wiidth 125.0000
Justification Center Center
Snappable Snappable Slant Angle 0"
LineSpacing 0.0000
Line Spacing Type  Bxact
Locked Unlocked Geometry ¥
Thickness 0.0000 WI
e [Raw Data o

Element properties can be edited from this dialog by selecting the field and either Key-inthe
new value or select from the drop-down menu.

Right clicking in the dialog will bring up the Show/Hide shortcut menu to control the display of

available tabs.
Quick Info

This dialog will display the element level and symbology. To access the dialog hover your
cursor over the element, hold down the Alt key, then <R> right click.

M Quick Info

Level E WTR
‘wieight o
Class Primary
Template None
Transparency D
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Analyze Element

The original Analyze Element dialog can be accessed using the Key-in
“analyze element”.

- =1

H Key-in
:g_naf_yze ele.ment |Y_| E 3 b

M Element Information E] O
-w |ine {3) General I De{ails] Pd'lribl.ﬂes] MNamed Groups I
Attributes Properies
Level: |P_MISC_CONSTD [~ Solid [ ]
Color: [ 2 [+ ] Snappable ]
Style: 0 [+ ]
Weight: 1 [» | View Dependent 1w
Modified [ ]
Mew [ ]
Mot Locked ]
Class: | Primany [i]
Priority: | 0 A L] [&]
—— GGroup: | 0
Transparency: | D Bl | (&) et
[ Cancel ] [ Apply l
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Text

Inserting Symbols

The Word Processor dialog has a new drop-down list for selecting symbols such as Degree,

Centerline, and Fractions.

ﬂ Text Editor - Word Processor

SEI]

P43 ENGINEERINY| B 7 U A° Al v m 1w~ H

; L T LR T T IR T T (TR T TR (T |:CEI’EE‘:I'|;'IE_ i
L) {m e—

% OF ROAD

5 =

To add symbols to the drop-down list, click on the Symbol icon.

e The Symbols dialog will appear.

e Select the character you want to add to the list and select the Insert icon.

M Symbols in ENGINEERING [3 & “
[ Mansge Favorite st | Selected: T
v [ " [ [ % [% & [« |1 8
* £ 4 s - / O 1 £ 3 |
5 | & | 1 : | =
& |8 |® € |p|E |[F | &0 &
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To manage a list of symbols select the Manage Favorite List icon. The Manage Favorite List
dialog will appear with options to sort, rename, and delete symbols from the list.

Manage Favorite List

Favorite character file:

C:\Documents and Settings\.. \FavoriteSymbols xml

| Centeriine
Degree

Superscript and Subscript

From the Word Processor dialog box two new buttons are added for placing Superscript and
Subscript text. Toggle on one of the scripts then type in the text in the Word Processor dialog.
Text placed will be smaller and the justification will be adjusted.

# Text Editor - Word Processor g
T A v/ B I U 21~-0 0~ @ -] L
- . . | . - . .
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Text Fields

Text fields can be inserted through the Word Processor dialog. Fields are values that are
specific to an element or design file. Values such as the length and direction of a line can be
input. Modifying the element will automatically update the text field with the new value.

& M Text Editor - Word Processor Q |m!
T s MBI U AE sl-mou-@)-
.;e T,
& PROPERTY LINE
.;" LENGTH: 22.25'
P DIRECTION: N34°30'52"E
J Select All
Clear
Find

Insert Field ¥ | Element Properties

Mode! Properties

i ———————

File Properties

When inserting the text field, select the format for display using the Active Settings or user
defined values.

M Fields Editor
Saneml Anearnike QML e ol
Label Format (Use Active Setti
Master Units  (Use Active Setti
B Sub Units (Use Active Setti
= Accuracy (Use Active Sett
E e i L
Prefix
Suffix
Decimal Sepa Period
e Thousands Se {None)
Geometry A Leading Zero | Show
Start 98.06.182.86 Trailing Zeros Show
End 110.67.201.19 Zero Master U Show
Length K Zero Sub Unit: Show
(Extended @
Raw Data o
2225
ok | [ cancel
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Edit Text and Data Fields

While using the Element Selection tool you can double click to edit text. Double clicking a data
field in the Word Processor dialog will open the Edit Enter Data Field dialog. This can be used
to modify the value, number of spaces, and justification of the Data Field.

“
Fo sTanDARD | B T U UF al- @ 0 - (§) -
v

PLACE -." PIPE

Enter data field: | 12
Length: | 2 =
Justification: | Left i

e ]

Spell Checker
Spell Checker now works with text that was placed using the Place Note command.
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Models

Model Properties

Models now include an attribute for defining a Line Style Scale. This is defined as a Property
of the model similar to Annotation Scale for text in version V8. Changing the Line Style Scale

will resize linestyles in the active model.

# Model Properties

_ * | Design | »
Mame: | COOT Default

Dezcription: | Master Model

Bef Logical:
A 1= v

| Lin= Style Scale: | Global Line Style Soals [+ 100000 |
[ ] Update Fields Autamatizally

Cell Properties
[ ] Can be placed az a cel

[ ak ] [ Cancel
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Cells

Annotation Scale

Cells can utilize the Annotation scale setting that is defined as a property of the model. This is
an expansion of the setting used by Text and Dimensions. When changing the model annotation
scale factor, the cells placed with annotation scale on will be resized.

# Cell Library: [...\MS XM Update\Civil\Resource\Topo. cel] =)
File

[] Use Shared Cells [] Display All Cells In Path Display: | Wireframe v
Name Diescription Type ..'.!-. Where A=

Bench Mark Prt A, by

C_Shrub Gph A, by

C_Tree Goh A, by

D_Shub Goh A, Lby

D_Tree Gph A by

Defautt Master Model Grph 1, Lby

Flag-Pole Pt A by o

Active Cells

M Place Active Cell

=)

w

Active Cell: | D_Tree Q
Active Angle: | 0.00° -
X Scale: | 1.000000 —

n —_—

Y Scale: | 1.000000 i

4

Note: The cell annotation factor only applies to cells placed with Annotation Scale toggled
on at time of cell placement

Attachment of Cell Libraries

Attaching an entire folder of cells can be accomplished from the Cell Library dialog pull-down
File > Attach Folder.

# Cell Library: [NONE] (=)
Eile
New... [] Display All Cells In Path Display: | Wirsframe b
Attach File...
I Attach Folder...l Description | Type| A | Where
Detach
Compress
Upgrade Files to V8.,
Active Cells
NONE Elmert
NONE NONE
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Enhanced References Dialog

M References (3 of 3 unique, 2 displayed) g
Tools  Settings
Ev k) DG A D A3 B 25 @ X Hickok [Bonies 3
Slat | ¥ | File Name Model Drezcription Logical Presentation | [« .9 & '__, |
1 123450ES_Model.dgn COOT Default Plan “igw plan_0 ‘wiireframe W
3 12348DES_Prof.dgn  CDOT Default Profile Wi praf_1 ‘whireframe W
Scale | 1.000000 .| 1.000000 Rotation | 0°0'0"
Dffset 1 | -178956.971 Y | -178956.971 £ | -178956.971 |l||._j f_1 :‘5]_«;: &F =]
Live Mesting s | | Allow Overides || Depth: | 2 Mew Level Display: | Config Variable | w|

Open in New Session — was added to the Tools pull-down and the shortcut Fly-out menus
to open the selected reference file in a new session of MicroStation.

Rotation — view and modify the rotation of a reference.
Offset — view and modify the difference in Global Origins.

Treat Attachment as Element for Manipulation — when this option is enabled, it will
allow the use of standard Manipulate tools with references, such as Move, Copy, and Rotate.
The pull-down and pop-up menu options are still available from the Reference File dialog.

New Level Display — controls the view display for new levels that are created in a reference
file. The three options are to use the Configuration Variable definition, Always On, or Never
On.

Move Boundary with Reference — when this option is enabled in the Move Reference
command it will allow the reference clip boundary to remain stationary allowing only the
reference file to be moved.

M

Move Boundary with Reference
Use References Dialog List

Reference File Types

Raster Reference file formats — new file formats include Adobe: PDF, I/RAS B such as
CLR, LRD, MPF and RST, JPG 2000: JPG, Enhanced Compression Wavelet: ECW

Reference Set key-ins

Reference Set key-ins — new set of key-ins that can be used on reference files during a
batch process for example enabling or disabling Display, Snap, Locate, and Treat As Element.
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Printing and Pen Tables

See the CDOT workflow document CDOT MicroStation Printing for printer driver and
pen table settings

Print dialog box
Use Full Sheet

This check box is only available when a Windows printer driver is selected. When checked,
the plot size can be expanded to the full dimensions of the selected paper size. It is up to the
user to ensure that the plotted elements are within the physical plot limits of the printer.
When unchecked the plot size is restricted to the physical plot limits of the printer. The plot
limits vary from printer to printer, however the plot limits for most printers is to within a %
inch on each side of the selected paper size. For a typical 8 %2 x 11 inch sheet you would be
restricted to a print area of 8 x 10 %2 inches.

#\ Print EPSON Stylus Photo R200 Series (CDOT-DefauliPrinter X... |- |

File Configuration Settings FPenTable

i L
i Q1+ i 8 ‘
General Sethngs
Area; | Fence w [] Rasterized
Caolor: | Monochrome | s Copies: | 1

Pen table: COOT-PenT able.thl

Printer and Paper Size
Windaws diiver s Q18 Fuil

i3 17l v
Total area: 17 %11 in.
Landscape | Send to printer [ Show design in preview A

Print Scale and Position
Secale: | 100.000 Q  1in. [paper] to 100.000 ' [design)

Size: | 17.000 11.000 in. Iﬂ b anirnize Rotation: | Mone w
Qrigir; | 0.000 Q000 in. [+] Auto-center

Print Destination

This option is only available when a Windows printer driver is selected. For any Windows
printer the user has three options:

Send to printer — sends plot directly to the selected printer (default)

Create plotfile — creates a plot file like the Bentley drivers
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Create metafile — creates a Windows Enhanced Metafile (.emf)

# Print \\spectrum\HP LaserJet 2300 Series PCL 6 (printer.pltcfg) |- |

File Configuration

General Settings

Color: | True Color

Pentable: Mone

Printer and Paper Size

Paper:  Letter
Total area:

Landscape |

Settings

o Q[+ I

PenTable

v Rasterzed

™ Copies: | 1

Windows diver  [s| & /B! Full
2

11x85in.

Send to printer [

Print Scale and Position

Scale: | 1.545 Q. 1in. {paper)to 1545 {design)
Size: | 11.000 7118 in. ﬂ Meandmize Blotation: | 0.0 deg.
Origin: | 0.000 0.691 in. Auto-certer Mimor: | Nane ™

Show design in preview &

Print Preferences

The Print Preferences dialog box includes a number of useful settings. Many of these
settings were only available through configuration variables in previous versions of
MicroStation. These settings are now maintained in the user preference file. Access this
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dialog from the Print dialog pull-down menu by selecting;
Settings > Preferences

M Print - Preferences g [

Uszer Interface

[] Mlow paper size edtting Hide advanced layout controls
Show print status dialog

Page Layout

Enable auto rotation [] Default form scale priorty
Enable auto orientation ] Maximize on new plot area
Enable scale preservation [] Fit with raster references

Enable scale clipping
Auto fit view: | None [ ]

Sheet Definition

Honor sheet definition [ Set units from sheet
Honor sheet layout Use sheet instead of fence
Honor sheet plot style table

Preview

[] Preview accurate rotation

Thumbnail preview timeout {sec) | 10

Print Engine

Apply color mode to raster
[] Use view background color when rendering

Print Phong render modes with shadows
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